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CURSO BÁSICO  
 AutoCAD R14 

 
 
 

Este material é de uso gratuito, use à vontade, mas não abuse !  
É permitida a distribuição, desde que seja feita gratuitamente, não seja alterado seu 
conteúdo, e sejam mantidos os créditos originais. Não é permitida a distri buição 
deste material em meios como CD de revista, internet ou qualquer outro meio de 
distribuição em massa sem o consentimento do autor, ou por meios que distribua 
material ilegal. 
 
  
 
Conheça o AditivoCAD. O aplicativo para AutoCAD, que vai aumentar de f orma 
significativa a sua produtividade na execução projetos de construção civil.  
 
Visite o site :   http://www.aditivocad.com 
E-mail :     contato@aditivocad.com 
 
 
Apostila Elaborada por Fredy Godinho Braga.  
Revisada pela ultima vez em  Janeiro/2002 
 
 
Faça um bom proveito ! 
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INTRODUÇÃO 
 
 
 

A execução do AutoCAD é feita atráves do icone da area de trabalho ou atráves do 
menu  iniciar – programas – AutoCAD r14.  
 
entrada de comandos no AutoCAD é feita através de três  modos: 

 

Via teclado - digita-se no prompt command do AutoCAD o nome do comando ou 
atalho correspondente  e logo em seguida tecle <enter>  
ex: digite  line ou apenas L , em seguida tecle  <enter> o  comando line (para 
desenhar linhas) será acionado. 

 
Via menu - seguindo com o mouse até os menus superiores  e clicando com o botão 
esquerdo do mouse sobre o comando desejado.  
ex: siga com o mouse até o menu Draw e clique na opção rectangle o comando 
rectangle (para desenhar retangulos) será acionado. 
 
Via toolbars – são caixas com icones que podem ser carregados e descarregados a 
qualquer momento , para acionar um comando via tollbar basta clicar com o botão 
esquerdo do mouse sobre o botão , para carregar ou descarregar  uma toolbar basta 
clicar com o botão esquerdo do mouse sobre qualquer botão, surgirá uma caixa na 
qual é possível faze-lo. 
 
Notas: 
Neste curso só estudaremos entradas de comandos atráves de  menu e teclado.  
Quando no prompt do AutoCAD estiver sendo apresentada alguma mensagem na 
frente do Command: algum comando está sendo executado no momento.  
Para quase todos os comandos do AutoCAD da mesma forma que é Necessário 
digitar <enter> para iniciar o comando é necessário digitar <enter>  para finalizar o 
commando. 
O botão direito do mouse serve como <enter> exceto em caso de comandos como 
Textos,  e o esquerdo serve para definir um ponto .  
Os arquivos do AutoCAD Tem extensão  .Dwg  
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ENTRADA DE PONTOS 
 

 

A Entrada De Pontos No AutoCAD É Feita Atráves De cliques na tela ou 
Coordenadas , os tipos de coordenadas utilizadas são: 
 
Coordenadas Absolutas : 
São Utilizadas Quando Se Sabe Os Valores Absolutos De  X, Y, Z, Do Sistema De 
Coordenadas Cartesianas. 
Sintase:  X,Y,Z  . 
 
Coordenadas Relativas: 
São Utilizadas Quando Se Sabe De X, Y, Z, Em Relação A Um Ponto Já 
Determinado Sua Entrada Deve Ser Sempre Precedida Do Simbolo De @.     
Sintase:  @X,Y,Z   . 
 
Coordenadas Polares: 
São Utilizadas Quando Se quer atingir um ponto a uma determinada distância e 
ângulo . Sua entrada também deve ser precedida do simbolo de @   e o Ângulo de 
rotação sempre precedido do sinal “<”.  
Sintase: @L<A  ,  onde L-Comprimento  A-Ângulo . 
 
Nota: 
O sentido de angulos no AutoCAD aumenta sempre no sentido Anti -Horário e 
diminuem no sentido horário. 

 

 
COMANDOS UTILITÁRIOS 
 
OPEN – abre um desenho existente. 
Acesso pelo teclado : open 
Acesso pelo menu : file > open  
Atalho : Ctrl+o 
 
NEW – inicia um novo desenho. 
Acesso pelo teclado : new 
Acesso pelo menu : file > new 
Atalho : Ctrl+n 
 
QSAVE – Salva um desenho já gravado no HD , caso o desenho não  tenha sido 
gravado o comando tem o mesmo efeito do comando SAVEAS. 
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Acesso pelo teclado : qsave 
Acesso pelo menu : file > Save 
Atalho : Ctrl+s 
 
SAVEAS . Salva um arquivo já gravado no HD com outro nome diferente ou um  
arquivo que não esteja gravado no HD. 
Acesso pelo teclado : saveas  
Acesso pelo menu : file > Saveas...  
 
UNDO - Desfaz um comando , seu número de operações é ilimitado  
Acesso pelo teclado : undo 
Acesso pelo menu : Edit > Undo 
Atalho : Ctrl+z ou u 
 
REDO - Desfaz o ultimo efeito do undo , seu nu mero de operações é  limitado em 
apenas 1 e o comando deve ser acionado logo após o acionamento do comando 
Undo. 
Acesso pelo teclado : redo 
Acesso pelo menu : Edit > Redo 
Atalho : Ctrl+y 
 
QUIT - Sai do AutoCAD . 
Acesso pelo teclado : quit 
Acesso pelo menu : Edit > Exit 
 
REDRAW – redesenha a tela do AutoCAD removendo “lixos” .  
Acesso pelo teclado : redraw  
Acesso pelo menu : View > Redraw 
Atalho : R 
 
REGEN – regenera a área de desenho.  
Acesso pelo teclado : regen 
Acesso pelo menu : View > Regen 
Atalho : Re 
 
ORTHO – Aciona o Modo ortogonal do AutoCAD permitindo desenhar linhas, 
arcos etc... em modo ortogonal  “0º 90º 180º 270º”  
Acesso: Basta Apertar a tecla  F8 
 
GRID – Aciona uma grade de pontos na área grafica que serve de base para 
desenhar objetos presos a uma determinada geometria. 
Sua configuração é feita através do comando ddrmodes , que será descrito 
posteriormente. 
Acesso: Basta Apertar a tecla  F7 
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SNAP – Controla a forma de deslocamento do cursor sobre o grid.  
Sua configuração é feita através do comando ddrmodes , que também será descrito 
posteriormente. 
Acesso: Basta Apertar a tecla  F9 
 
CAL – aciona a calculadora do AutoCAD, as expressões devem obedecer as regras 
matemáticas , estando sempre entre parentes , os operadores são:  
*   - multiplicação. 
/    - divisão. 
+   - soma. 
 - subtração. 
( ) expressões em grupos. 
 
Acesso: Basta digitar CAL no prompt 
 
Nota: o cancelamento de um comando é feito através da tecla de função Esc . 

 

 

INICIALIZAÇÃO DE UMA SEÇÃO DE TRABALHO 
 
Sempre que se inicia o AutoCAD é Apresentada uma caixa de diálogo  Startup na 
qual é Possível fazer algumas configurações que são necessárias para iniciar uma 
seção de trabalho, ou selecionar um arquivo protótipo já configurado. É possivel 
Também Adicionar um arquivo padronizado para ser utilizado como protótipo , 
bastanto apenas configurar o arquivo desejado e salvá -lo com a extensão .Dwt 
“Template” algumas destas configurações já foram descritas anteriormente (Ex: 
configuração do Grid.) Por questões práticas faremos as outras configurações 
dentro do próprio AutoCAD. 

 

 

PREPARANDO A ÁREA  DE TRABALHO 
 
LIMITS – com este comando é possível definir o limite da área de trabalho.  
Acione o comando, em seguida o AutoCAD apresentará as seguintes mensagens:  
Lower Left Corner  - Canto inferior Esquerdo . Deixe 0,0 
Uper Rigth Corner  - Canto Superior Direito . Determine um valor Para X e Y , Ex: 
se for Digitado 12,9  Sua área de trabalho terá 12.00x9.00 unidades.  
Acesso pelo teclado: limits 
Acesso pelo menu: format >drawing limits 
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DDUNITS – Este comando acionará uma caixa na qual será posível determinar a 
unidade de medida a ser usada como também a quantidade de casas decimais .  
Apesar de apresentar várias opções poucas serão úteis à nós pois não são 
compativeis com nosso sistema de medidas , o decimal métrico 
Na opção units selecione decimal e logo abaixo selecione o número de casas 
decimais. 
Já na opção angles selecione decimal degrees para ângulos decimais ou ainda 
Deg/Min/Sec para determinar ângulos com graus/minutos/segundos , E logo abaixo 
selecione as casas decimais 
No botão direction... é possível  determinar a direção dos angulos. Opções:  
East - define o angulo 0 como leste.  
North - define o angulo 0 como norte.  
West - define o angulo 0 como oeste.  
South - define o angulo 0 como sul.  
Other - define o angulo 0 como um angulo qualquer a ser definido na opção Angle 
ou ainda na opção Pick< que pede um clique na tela.  
Couter Clockwise – define os angulos em sentido anti -horário .  
Clockwise - define os angulos em sentido horário.   
Não é recomendavél modificar o sistema de ângulos do AutoCAD , a não ser em 
caso de necessidade , já que é adotado pela maioria dos usuários do AutoCAD o 
sistema Default do AutoCAD. 
Acesso pelo teclado: ddunits 
Acesso pelo menu: Format > Units... 
 
 
DDRMODES – Aciona uma caixa de diálogo na qual é feita alguma configuração 
descrita anteriormente entre outras , não descreveremos todas , pois outras não são 
de interesse para nosso curso e outras são mais facilmente acessíveis através de 
outros modos , ex: o acionamento do Ortho é mais rápido e fácil atraves da tecla de 
função F8. 
Vejamos algumas das configurações: 
 
No campo Modes. 
Solid fill – Controla o preenchimento de regiões sólidas preenchidas por exemplo 
pelo comando Solid que será estudado mais adiante.  
Blips – Controla o aparecimento de blips na tela. 
Highligth – Controla se os objetos selecionados por qualquer dos modos de seleção 
do AutoCAD , serão destacados.  
 
No campo Snap. 
X spacing – controla o valor do deslocamento do Snap em X.  
Y spacing – controla o valor do deslocamento do Snap em Y. 
 
No campo Grid . 
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X spacing – controla o valor do espaçamento do Grid em X.  
Y spacing – controla o valor do espaçamento do Grid em Y.  
 
No campo Isometric. 
É possível acionar o modo isométrico do AutoCAD. 
Em Left, Top e Rigth  - controla se o modo será  esquerdo, topo ou direito . 
respectivamente , podem ser acessados também através da tecla F5.  
Acesso pelo teclado: ddrmodes 
Acesso pelo menu: tolls > Drawing Aids...  
 
É necessária mais uma série de configurações para ser dada como complet a a 
inicialização de uma seção de trabalho, mas por enquanto é só , veremos mais no 
decorrer do curso. 

 

VISUALIZAÇÃO DO DESENHO 
 
A visualização no AutoCAD é feita atráves do comando Pan e Zoom que tem uma 
série de variações, são elas:  
 
COMANDO ZOOM. 
Zoom all  - visualiza todo o desenho dentro do limite de trabalho na tela.  
Zoom center – pede por um ponto central na tela e em seguida pela altura da janela a 
ser exibida. 
Zoom dynamic – mostra na tela grafica 2 retangulos , um branco o limite do desenho 
, o outro verde e pontilhado indica qual parte estava visível antes do acionamento do 
zoom dynamic 
Zoom extents – mostra todo o desenho existente na extensão da tela  
Zoom previous – recupera a ultima imagem apresentada por qualquer uma das 
variações do comando zoom 
Zoom scale – Especifica um fator de escala em relação ao desenho se seu valor for 
maior que 1(um) o desenho aumenta proporcional ao valor se for menor diminui , e 
se for igual não tem efeito. 
Zoom window – visualiza uma área especificada por dois pontos que representam 
uma janela. 
Zoom realtime  - da uma vista em tempo real do desenho apliando e diminuindo 
dinamicamente, o zoom realtime é acionado teclando <enter> quando o AutoCAD 
apresenta as opções do comando zoom.  
Acesso pelo teclado : zoom  
Acesso pelo menu : view > zoom  
Atalho : Z 
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Nota: logo que acionado o comando o AutoCAD apresentará as opções do comando 
zoom para acessar a cada uma das variações do comando basta observar no prompt 
qual a letra no nome da variação está em maiúscula e digita -la seguido de um enter. 
 
COMANDO PAN 
Move a tela dando uma vista do desenho em tempo real semelhante ao zoom 
realtime. 
Acesso pelo teclado: Pan   
Atalho : P 
 

 

FERRAMENTAS DE PRECISÃO 
 

Tem por objetivo localizar pontos precisos de objetos.  
 
OSNAP – localiza pontos precisos de objetos,  acessado através de um menu 
flutuante que é acionado apertando simultaneamente o botão direito do mouse e a 
tecla “SHIFT”. Logo que acionado o menu apresenta as seguintes opções :  
 
Tracking- Localiza um ponto a partir de uma série de pontos temporários. 
From – Estabelece um ponto para que apartir dele seja determinado o ponto 
desejado usando coordenadas relativas.  
Point filters – Filtra as coordenadas X,Y,Z referentes a um ponto .  
Endpoint – Localiza o ponto final mais proximo de objetos. 
Midpoint – Localiza o ponto medio mais proximo de objetos.  
Intersection – Localiza a intersecção mais proxima de  objetos.  
Apparent intersect– Localiza a intersecção aparente a de objetos.  
Center  - Localiza o centro de circulos e arcos.  
Quadrant – Localiza os quadrantes de um círculo , 0º , 90º , 180º e 270º.  
Tangent – Localiza um ponto de tangência de um circulo ou arco.  
Perpendicular – Localiza pontos perpendiculares à objetos.  
Node – Localiza um ponto desenhado através do comando Point.  
Insert – Localiza o ponto de inserção de textos e Blocos.  
Nearest – Localiza o ponto mais próximo de um objeto.  
None – Cancela todos os modos osnap ativados.  
Osnap settings ... – Aciona uma caixa de diálogo na qual é possível  
fixar os Snaps dentro da caixa do osnap settings na opção Autosnap™ controla -se a 
configuração do osnap , as principais são:  
 
Marker – Ativa ou desativa  a figura que representa o snap .  
Snap Tip – Ativa ou desativa o nome do snap selecionado.  
Marker color – controla a cor do marker.  
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Nota importante: 
Os modos de Precisão do Osnap não são comandos , são ferramentas de Precisão . 
Portanto deve haver uma justificativa para se acionar qualquer das ferramentas.  
Por exemplo : Se você acionar o modo Endpoint sem nenhuma justificação , o 
AutoCAD irá apresentar uma mensagem semelhante a “Unknow command” , ou 
seja comando desconhecido pois como já foi dito os Snaps não são comandos. 

 

 

CRIANDO PROPRIEDADES PARA OBJETOS 
 

 
DDCOLOR – define a cor que os objetos serão desenhados , assim que acionado o 
comando,  surgirá uma caixa com 255 cores, você poderá escolher uma que será a 
cor corrente do desenho , se você optar por BYLAYER será obedecida a cor 
definada pelo comando LAYER o que é mais recomendável em termos de 
organização. 
Acesso pelo teclado: ddcolor   
Acesso pelo menu: format > color 
Atalho : col 
 
 
LAYERS – layers são camadas do desenho . Para se ter uma boa ideia de como 
funcionam essas camadas , imaginemos que layers são como camadas de papel 
transparente , nas quais são representadas diferentes informações do desenho . Por 
exemplo: imagine que  você possui 4 camadas desses papeis em uma você tem 
desenhos de paredes , na outra desenho de cotas , outra desenhos de esquadrias e na 
outra desenho de textos , todos de um mesmo projeto , se você encai xá-las 
perfeitamente você montará seu projeto e como os papeis são transparentes só será 
visualizado o desenho . 
Trabalhando com layers você tem mais fexibilidade para manipular seu 
desenho , suponhamos que no mesmo projeto exemplificado anteriormente 
você prescise aproveitar somente paredes e esquadrias  ao invés de você copiar 
o mesmo projeto e apagar os objetos que não serão necessários , pode -se 
congelar os objetos que não serão necessários e copiar os objetos descongelados 
, tendo assim um maior produtividade . 
Através do comando LAYER é possível criar e gerenciar estas camadas.  
Opções  
Acionando o comando o gerenciador será apresentado :  
New : é possível criar novos layers.  
On : é possível ligar/desligar um layer , um objeto que tem seu layer desligado  fica 
visível no desenho, porém não pode ser manipulado .  
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Freeze in all viewports : é possível congelar/descongelar um layer, um objeto que 
tem seu layer congelado fica invisível no desenho e não pode ser manipulado, não é 
possível congelar um layer corrente. 
Lock : é possível trancar/destrancar um layer, um objeto com seu layer trancado fica 
visível no desenho , porém impossível de ser manipulado.  
Color : é possível atribuir  uma cor para determinado layer, após atribuir a cor , 
todos os objetos que forem desenhados naquele layer terão a cor que foi atribuida ao 
layer , a não ser que a cor tenha sido definida no comando DDCOLOR diferente de 
Bylayer . 
Linetype : é possível atribuir um tipo de linha a um determinado layer , funciona 
semelhante à opção color , com uma diferença, o tipo de linha é definido dentro do 
proprio gerenciador de layer . 
Delete : é possível apagar um layer, o layer a ser apagado não pode ter  nenhum 
ojeto desenhado relacionado à ele. 
Current : é possível tornar um layer corrente. 
Acesso pelo teclado: layer   
Acesso pelo menu: format > layer 
Atalho : la 

 

PRIMITIVAS GEOMÉTRICAS 
 
Nesta parte do curso começamos a realmente desenhar com o AutoCAD , veremos a 
seguir o processo de criação de objetos a partir de entidades do próprio AutoCAD. É 
importante reasaltar que todo o desenho feito no AutoCAD é na realidade um 
conjuto de entidades primitivas que representam objetos .  
Ex: Uma janela nada mais é para o AutoCAD do que várias entidades, o programa 
não a entende como uma janela.  
Como foi dito no início do curso,  sempre que no  AutoCAD estiver sendo 
apresentada alguma mensagem na frente do prompt Command: algum comando está 
sendo executado no momento, então procure prestar atenção no prompt quando 
estiver executando algum comando, isto além de fundamental facilitará o 
entendimento do comando . 
 
LINE – Gera linhas a partir de pontos dados na tela por cliques ou por coordenadas.  
Entendendo o comando. 
Acione o comando . 
From point:  - pede pelo ponto inicial da linha .  
To point: - pede pelo próximo ponto da linha , continuará sempre com esta 
mensagem sempre que que o comando seja dado por encerrado <enter>.  
Acesso pelo teclado : line  
Acesso pelo menu : Draw > Line  
Atalho : L 
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CIRCLE – Gera círculos definidos por pontos e valores de diametro e rai o.  
Opções do comando: 
Center Radius: pede por um ponto central e um raio.  
Center Diameter: pede por um ponto central e um diamentro.  
2 Points ou 2P: pede por dois pontos que seram tomados como base para o desenho 
do círculo. 
3 Points ou 3P: pede por três pontos que seram tomados como base para o desenho 
do círculo. 
Tan Tan Radius ou TTR: pede por dois objetos e um valor para o raio  e desenha o 
circulo  tangênte aos objetos com o raio especificado.  
Tan Tan Tan: pede por três objetos e desenha o circulo  ta ngênte aos objetos, só é 
acessado através do menu. 
Acesso pelo teclado : circle 
Acesso pelo menu : Draw > Circle  
Atalho : C 

 
ARC – Gera arcos especificados pelos seus pontos notáveis e por valores.  
São eles: 
Start – inicio do arco. 
End – final do arco. 
Center – centro do arco. 
Angle – determina o angulo . 
Direction – determina a direção do arco. 
Radius – determina o raio do arco. 
Length – determina o comprimento da corda do arco. 
Nota: nos sub-menus do comando Arc são apresentadas uma série de combinações  
para desenhos de arcos. Ex: Start , Center , End. Constrói um arco baseado em início 
meio e fim 
Acesso pelo teclado : Arc 
Acesso pelo menu : Draw > Arc  
Atalho : A 

 

 

 
RAY – Funciona como o  Line , gerando linhas a partir de cliques ou coordenadas , 
porém linhas semi-infinitas , apenas seu início é conhecido.  
Entendendo o comando: 
Acione o comando . 
From point:  - pede pelo ponto inicial da ray.  
Through point: - pede pelo ponto de direção da ray , continuará sempre com esta 
mensagem sempre que que o comando seja dado por encerrado <enter>.  
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Acesso pelo teclado : ray 
Acesso pelo menu : Draw > Ray  

 

 
XLINE – Funciona como o  Ray , gerando linhas a partir de cliques ou coordenadas 
, porém linhas infinitas , apenas seu meio é conhecido.  
Entendendo o comando: 
Acione o comando . 
From point:  - pede pelo ponto inicial da xline 
Through point: - pede pelo ponto de direção da xline , continuará sempre com esta 
mensagem sempre que que o comando seja dado por encerrado <enter>.  
Nas opções Hor, Ver, Ang  é possível gerar as linhas na horizontal vertical ou com 
angulo especifico respectivamente .  
Na opção bisect  cria-se as linhas passando pela bissetriz do angulo escolhido por 
três pontos: Angle vertex point: vértice , Angle start point: 1º ponto do angulo 
,Angle end point: proximo ponto do angulo. 
Acesso pelo teclado : xline 
Acesso pelo menu : Draw > Xline  
Atalho : xl 
 

 
PLINE – Gera uma polyline definida por vários pontos, uma polyline nada mais é 
do que um conjunto de linhas e objetos agrupados.  
Entendendo o comando: 
Acione o comando . 
From point:  - pede pelo ponto inicial da polyline 
Endpoint of line: - pede pelo próximo ponto da polyline , continuará sempre com 
esta mensagem sempre que que o comando seja dado por encerrado <enter>.  
O comando Pline apresenta uma série de opções , vejamos algumas delas:  
Arc  :  troca o desenho de linhas por arcos , para voltar a opção de linhas basta 
digitar L. 
Halfwidth :  determina a meia largura de uma polyline. Na opção Starting half -with 
determina a meia largura inicial, e na opção   
Ending half-with determina a meia largura final.  
Length: Desenha un segmento com comprimento definido na mesma direção do 
segmanto anterior. 
Width: funciona como halfwidth com a diferença de determinar a lagura total da 
polyline 
Acesso pelo teclado : pline 
Acesso pelo menu : Draw > Polyline  
Atalho : pl 
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POLYGON – Gera poligonos. 
Entendendo o comando: 
Acione o comando . 
POLYGON Number of sides < >: pede pelo número de lados do poligono 
inicialmente  o sistema default apresenta <4> , mas você pode fornece r de 3 a 1024 
lados. 
Edge/<Center of polygon>: pede por um ponto que será o centro do poligono.  
Inscribed in circle/Circumscribed about circle (I/C) <I>:  define o poligono como 
inscrito <I> (diametro externo) ou circunscrito <C>.(diametro interno)  Radius of circle: 
pede pelo raio do poligono.  
Opções do comando: 
Edge :  pode-se definir o poligono pela dimensão de seu lado e sua inclinação.  
Acesso pelo teclado : polygon 
Acesso pelo menu : Draw > Polygon  
Atalho : pol 
 

 
RECTANGLE – Gera Retangulos . 
Entendendo o comando: 
Acione o comando . 
Chamfer/Elevation/Fillet/Thickness/Width/<First corner>: pede pelo primeiro 
ponto que define o retangulo. 
Other corner: pede pelo outro ponto que define o retangulo. 
Algumas das opções do comando: 
Chamfer: permite definir o valor do chamfro para desenhar o retangulo chamfrado.  
Fillet: permite definir o valor do raio para desenhar o retangulo com os cantos 
arredondados . 
Width: permite definir uma espessura para as linhas do retangulo.  
Acesso pelo teclado : Rectangle 
Acesso pelo menu : Draw > Rectangle  
Atalho : rec 
Nota: o Retangulo é reconhecido pelo AutoCAD como uma polyline.  
 
 
ELLIPSE – Gera elipses ou arco eliptco. 
Entendendo o comando: 
Acionando o comando pelo menu você verá as seguintes opções apresentadas no 
sub-menu: 
 
Center  
Center of ellipse: pede o centro da elipse. 
Axis endpoint: define  um dos eixos da elipse.  
<Other axis distance>/Rotation: define o outro eixo da elipse .  
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Axis End 
Arc/Center/<Axis endpoint 1>: define  um eixo da elipse.  
Axis endpoint 2: define  outro dos eixos da elipse .  
<Other axis distance>/Rotation: define  outro dos eixos da elipse rotacionando-a. 
 
Arc 
<Axis endpoint 1>/Center: pede o centro do arco eliptico. 
Axis endpoint 2: pede um ponto que definirá a distancia de um dos eixos.  
<Other axis distance>/Rotation: pede um ponto que definirá o outro eixo.  
 
Parameter/<start angle>: 1º ponto para definir o angulo do arco. 
Parameter/Included/<end angle>: 2º ponto para definir o angulo do arco.  
 
Acesso pelo teclado : Ellipse 
Acesso pelo menu : Draw > Ellipse 
Atalho : el 
 
MLINE – Gera múltiplas linhas. 
Entendendo o comando: 
Acione o comando . 
Justification/Scale/STyle/<From point>: pede pelo ponto inicial .  
<To point>: pede o próximo ponto , e continua a pedir um próximo ponto 
funcionado do seguinte modo.  
Undo/<To point>: pede o próximo ponto ou “Undo” para voltar ao ponto anterior.  
Close/Undo/<To point>: pede o próximo ponto ou “Undo” para voltar ao ponto 
anterior ou ainda “Close” para fecha-la. 
Opções do comando. 
Justification – permite fazer uma justificativa para o desenho da mline, são elas:  
Top :  Desenha com o cursor no topo da esquerda para direita.  
Zero :  Desenha com o cursor no centro.  
Botton : Desenha com o cursor abaixo da esquerda para direita.  
Scale : Cotrola a largura da Mline. 
Acesso pelo teclado : Mline 
Acesso pelo menu : Draw > Multiline 
Atalho : ml  
 
SPLINE – Gera curvas splines , muito úteis para desenhos de curvas de nível por 
exemplo. 
Entendendo o comando: 
Acione o comando . 
Object/<Enter first point>: pede o ponto inicial. 
Enter point: pede o próximo ponto , e continua pedindo até que seja terminado os 
pontos , e apresenta as seguintes mensagens.  
Enter start tangent: pede o ponto que formará a tangente com o ponto inicial.  
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Enter end tangent: pede o ponto que formará a tangente com o ponto final.  
Acesso pelo teclado : spline 
Acesso pelo menu : Draw > spline 
Atalho : spl  
 
 
DONUT – Gera coroas circulares ou circulos preenchidos.  
Entendendo o comando: 
Acione o comando . 
Inside diameter <   >: pede pelo diametro interno . 
Outside diameter <   >: pede pelo diametro externo. 
Center of doughnut: pede pelo centro do DONUT. 
Acesso pelo teclado : Donut 
Acesso pelo menu : Draw > Donut 
Atalho : do 
 
 
POINT  - Desenha pontos na tela.  
O comando pede apenas POINT Point: ou seja , de um clique na tela para definir o 
ponto que será desenhado o ponto , os pontos podem ser desenhados das seguintes 
formas:  apenas um   (single) ou pontos múltiplos (mutiple) , no caso de pontos 
múltiplos o comando só será encerrado atráves de cancelamento , existem vá rios 
tipos de pontos que podem ser desenhados , eles podem ser definidos atráves do 
comando DDPTYPE que será comentado a seguir.  
Acesso pelo teclado : point 
Acesso pelo menu : Draw > point 
Atalho : po 
 
 
DDPTYPE 
Basta acioná-lo e surgirá uma caixa com as opções apartir daí escolha o ponto dando 
um clique sobre ele e em seguida OK.  
Na opção set size relative to screem  define-se um fator de escala em relação à tela 
do AutoCAD.   
Na opção set size in absolute units define-se um fator de escala em relação à 
unidades de medidas do AutoCAD.   
Acesso pelo teclado : ddptype 
Acesso pelo menu : format > point style 
 
 
SOLID  - Desenha figuras sólidas como retangulos .  
Entendendo o comando: 
Acione o comando . 
SOLID First point: pede pelo primeiro ponto da figura a ser desenhada. 
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Second point: pede pelo segundo ponto da figura a ser desenhada.  
Third point: pede pelo terceiro ponto da figura a ser desenhada.  
Fourth point: pede pelo quarto ponto da figura a ser desenhada.  
Continuará pedindo  “Third point:  Fourth point:” respectivamente e dando 
continuidade a figura até que seja dado um <enter> para encerrar o comando.  
Nota: um modo mais rápido de se preencher uma figura fechada com sólido é 
utilizando hachuras , o comando para gerar hachuras será explicado mais adiante.  
Acesso pelo teclado : solid 
Acesso pelo menu : draw > surfaces > 2d solid...  
Atalho : so 
 
Gerando textos no desenho .  
DTEXT  - Escreve textos no desenho. 
Opções de comando : 
Justify/Style/<Start point>:pede por um ponto inicial do texto , justificação ou esti to 
de texto. 
Height <  >: Pede pela altura do texto. 
Rotation angle <0>: Pede pelo angulo de rotação do texto.  
Text: Pede pelo texto , sempre que for dado um <enter> o texto pula a linha para 
encerrar o comando é necessário  2 <enter> seguidos.  
Justify – Permite a justificação de um texto , as mais importantes são: Align , Fit , 
Center , Midle , Rigth . 
Align  -  Faz com que a largura do texto seja controlada por dois pontos e altera sua 
altura proporcionalmente.   
Fit  -  Faz com que a largura do texto sej a controlada por dois pontos sua altura não 
é alterada.   
Center – Faz o alinhamento pelo ponto médio da base do texto.  
Middle – Faz o alinhamento pelo ponto médio do texto.  
Rigth –  Faz o alinhamento pela direita do texto.  
TL (top left) – alinha pelo topo à esquerda. 
TC (top center) – alinha pelo topo ao centro. 
TR (top rigth) – alinha pelo topo à direita. 
ML (middle left) – alinha pelo ponto médio à esquerda.  
MC (middle center) – alinha pelo ponto médio ao centro.  
MR (middle rigth) – alinha pelo ponto médio à direita. 
BL (botton left) – alinha pelo base à esquerda.  
BC (botton center) – alinha pelo base ao centro.  
BR (botton rigth) – alinha pelo base à direita.  
Style – especifica um estilo de texto como corrente.  
  
Edição de caracteres especiais: 
 
%%oCurso – resulta em   Curso 
%%uCurso – resulta em   Curso 
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45%%d – resulta em    45º 
%%p125kg – resulta em   ±125kg  
%%c10.0mm – resulta em Ø10.0mm 
 
Acesso pelo teclado : dtext 
Atalho :dt 
 
 
MTEXT – cria um texto com várias linhas com um páragrafo , ao contrário d o 
Dtext Mtext considera todas as linhas do texto como um único objeto. As 
especificações de alturas larguras etc.. são iguais ao comando Dtext exceto pelo fato 
dos textos serem feitos através de uma caixa de diálogo.  
Acesso pelo teclado : mtext 
Acesso pelo menu : draw > text >multiline text 
Atalho :mt 
 
 
STYLE – permite a criação de um estilo de texto, logo que o comando for acionado 
será inicializada uma caixa com os seguintes campos:  
 
Style name :  
New... - define-se um novo estilo de texto. 
Rename... -  Renomeia-se um estilo existente. 
Delete - apaga-se um estilo de texto, o texto a ser apagado não pode ser um estilo de 
texto que tenha sido usado no desenho.  
 
Font: 
Font Name – define  a fonte a ser usada no estilo de texto.  
Font Style – define o estilo quanto a negrito itálico etc...  
Heigth – define a altura do estilo de texto , recomenda-se deixar 0.0 pois assim 
sempre que se for digitar um novo texto o AutoCAD pedirá uma nova altura.  
 
Effects : 
Upsidedown – gera o texto espelhado na horizontal.  
Backwards – gera o texto espelhado na vertical.  
Vertical – gera o texto escrito na vertical.  
Width factor – especifica a largura do texto em relação a altura.  
Obliquing angle – define o angulo de inclinação das letras.  
 
No botão Apply aplica-se as definições do esti lo e define-o como corrente. 
 
Acesso pelo teclado : style 
Acesso pelo menu : format > text style  
Atalho : st 
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HATCH – cria hachuras no desenho em objetos que sejam considerados limites.  
O comando é executado a partir de caixa de diálogo.  
 
Opções:  
Pattern... – define o estilo de Hachura a ser usado.  
Scale – define o fator de escala da hachura.  
Angle – define o angulo de rotação da Hachura.  
Spacing – define o espaçamento da hachura definida como User defined . 
Pick points – pede um clique no interior da área a ser preenchida. 
Select object – pede a seleção dos objetos que formarão o limite da  
hachura. 
Double  – desenha a hachuria duplicada.  
Preview Hatch < - da uma prévia do que será a hachura.  
Apply – aplica a hachura. 
 
Acesso pelo teclado : hatch 
Acesso pelo menu : draw > hatch 
Atalho : h 
 

 

METODOS DE SELEÇÃO DE OBJETOS 
 
Os métodos de seleção de objetos são uteis quando se quer editar ou modificar 
objetos já existentes , são acessados no prompt command: e não são comandos do 
AutoCAD , são metodos de seleção que serão usados dentro de comandos .  
Ex: quando se aciona o comando Erase que é um comando para apagar objetos é 
apresentada a seguinte mensagem no prompt do AutoCAD - Select objects: ou seja 
Selecione objetos é nessa hora que podem e devem ser utiliz ados os métodos de 
seleção . 
 
ALL – Seleciona todos os objetos do desenho cujo layer esteja descongelado.  
CROSSING – seleciona os objetos que cruzem uma determinada janela retangular .  
( C ) 
CPOLYGON – semelhante ao crossing , com a diferença da janela se r em forma de 
um poligono. ( CP ) 
FENCE – seleciona os objetos que cruzem uma linha de seleção. ( F )  
LAST – seleciona o último objeto visível criado. ( L )  
PREVIOUS – seleciona o conjunto mais recente selecionado. ( P )  
UNDO – cancela o ultimo objeto selecionado. ( U ) 
WINDOW – seleciona objetos que se encontrem inteiramente dentro de uma janela.  
( W ) 
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WPOLIGON – semelhante ao window , com a diferença da janela ser em forma de 
um poligono. ( WP ) 
ADD – adiciona objetos na seleção. 
OOPS – restaura o ultimo objeto apagado. 
  

 ALTERANDO PROPRIEDADES DE OBJETOS 
 
Nessa parte do curso começaremos a estudar formas de se alterar as características 
de um objeto desenhado no AutoCAD , usando comandos de alteração .  
 
ERASE – apaga objetos . 
Entendendo o comando. 
Acione o comando: 
O AutoCAD apresentará a seguinte mensagem:  
select objects: selecione os objetos usando um método de seleção, após selecionar 
os objetos basta dar <enter> para finalizar o comando.  
Acesso pelo teclado : erase 
Acesso pelo menu : modify > erase 
Atalho : e 
 
 
COPY – copia objetos . 
Entendendo o comando. 
Acione o comando: 
O AutoCAD apresentará as seguintes mensagens:  
select objects: selecione os objetos usando um método de seleção, após selecionar 
os objetos basta dar <enter> para finalizar a sele ção. 
<Base point or displacement>/Multiple: clique em um primeiro ponto base pelo 
qual será arrastado o objeto. 
 Second point of displacement: clique em um segundo ponto que será o ponto base 
para onde  o objeto será copiado. 
Na opção Multiple: é possível fazer cópias múltiplas do objeto. 
Acesso pelo teclado : copy 
Acesso pelo menu : modify > copy 
Atalho : cp  ou  co 
 
 
MOVE– move os objetos. 
Entendendo o comando. 
Acione o comando: 
O AutoCAD apresentará as seguintes mensagens:  
Select objects:selecione os objetos a serem movidos ultilizando um método de 
seleção. 
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Base point or displacement: clique no ponto  base que será arrastado o objeto.  
Second point of displacement: clique no ponto para onde o objeto será arrastado.  
Acesso pelo teclado : move 
Acesso pelo menu : modify > move 
Atalho : m 
 
OFFSET–  faz copias paralelas de objetos, não tem efeito sobre todas as entidades 
do AutoCAD , ex: textos. 
Entendendo o comando. 
Acione o comando: 
O AutoCAD apresentará as seguintes mensagens:  
Offset distance or Through <Through>:  especifique a distancia entre as cópias.  
Select object to offset: selecione o objeto para copiar. 
Through point: selecione o lado da cópia dando um clique.  
Acesso pelo teclado : offset 
Acesso pelo menu : modify > offset 
Atalho : o 
 
 
TRIM– corta o excedente de um objeto até um limite definido por outro objeto.  
Entendendo o comando. 
Acione o comando: 
Select objects: selecione os objetos que serviram como limites .  
<Select object to trim>/Project/Edge/Undo: selecione os objetos a serem cortados 
Acesso pelo teclado : trim 
Acesso pelo menu : modify > trim 
Atalho : tr 
 
 
FILLET– faz um arredondamento ou concordancia entre linhas.  
Entendendo o comando. 
Acione o comando: 
(TRIM mode) Current fillet radius = 0.5000 – informa o raio do arredondamento 
Polyline/Radius/Trim/<Select first object>: pede a seleção do primeiro objeto. 
Select second object: pede a seleção do segundo objeto.  
Opcionais . 
Polynine : executa aredontamento em polynines. 
Radius : determina o raio do arredondamento. 
Trim : controla se seram cortados os lados selecionados até os pontos extremos da 
linha de arredondamento. 
Acesso pelo teclado : fillet 
Acesso pelo menu : modify > fillet 
Atalho : f 
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EXTEND– extende objetos até um limite definido por outros objetos.  
Entendendo o comando. 
Acione o comando: 
Select objects: selecione os objetos que serviram como limites .  
<Select object to extend>/Project/Edge/Undo: selecione os objetos a serem 
extendidos . 
Acesso pelo teclado : extend 
Acesso pelo menu : modify > extend 
Atalho: ex 
 
ROTATE– rotaciona objetos em torno de um ponto . 
Entendendo o comando. 
Acione o comando: 
Select objects: pede a seleção dos objetos a serem rotacionados.  
Base point: pede o ponto base pelo qual o objeto será rotacionado.  
<Rotation angle>/Reference: pede o angulo de rotação dos objetos, poderá ser um 
valor numérico ou um clique na tela  
Acesso pelo teclado : rotate 
Acesso pelo menu : modify > rotate 
Atalho : ro 
 
 
MIRROR– faz o espelhamento de objetos.  
Entendendo o comando. 
Acione o comando: 
Select objects: selecione os objetos que seram espelhados . 
First point of mirror line: selecione o primeiro ponto do eixo de espelhamento  
Second point: selecione o segundo ponto do eixo de espelhamento  
Delete old objects? <N> : pergunta se o objeto velho deverá ser espelhado.  
Acesso pelo teclado : mirror 
Acesso pelo menu : modify > mirror 
Atalho : mi 
 
 
STRETCH– estica parte do desenho. 
Entendendo o comando. 
Acione o comando: 
Select objects to stretch by crossing-window or crossing-polygon...  
A linha acima informa que os objetos devem ser se lecionados via Crossing ou 
Cpolygon . 
Select objects: pede a seleção dos objetos.  
Base point or displacement: pede o primeiro ponto base para esticar o objeto.  
Second point of displacement: pede o segundo ponto base para esticar o objeto.  
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Acesso pelo teclado : stretch 
Acesso pelo menu : modify > stretch 
Atalho : s 
 
 
CHAMFER– executa chamfros ou concordancia entre objetos.  
Entendendo o comando. 
Acione o comando: 
(TRIM mode) Current chamfer Dist1 = 0.5000, Dist2 = 0.5000.  
A linha acima informa as distancias entre os chamfros. 
Polyline/Distance/Angle/Trim/Method/<Select first line>: pede a seleção do 
primeiro objeto. 
Select second line: pede a seleção do segundo objeto.  
Opcionais . 
Polyline: - executa chamfros em polylines , funciona semelhante ao FILLET. 
Distance: permite que seja alterada as distancias do chamfro.  
Angle: permite que seja especificado um angulo e uma distancia para o chamfro.  
Trim: controla se os lados seram cortados como no comando FILLET. 
Method : especifica se o metodo será distance/distance ou angle/distance . 
Acesso pelo teclado : chamfer 
Acesso pelo menu : modify > chamfer 
Atalho : cha 
 
 
BREAK– remove parte de objetos. 
Entendendo o comando. 
Acione o comando: 
Select object: pede a seleção do objeto a ser quebrado.  
Enter second point (or F for first point): pede o segundo ponto do objeto a ser 
quebrado, caso for selecionado um segundo ponto será entendido como o primeiro o 
ponto que foi clicado na seleção do objeto , se preferir faça opção “ (or F for first 
point):” digitando F e o AutoCAD pedirá o primeiro ponto. 
Acesso pelo teclado : break 
Acesso pelo menu : modify > break 
Atalho : br 
 
 
ARRAY– cria várias cópias de um ou mais objetos em sequencias de linhas e 
colunas 
Entendendo o comando. 
Acione o comando: 
Select objects: selecione os objetos que seram copiados .  
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Rectangular or Polar array (<R>/P): selecione R ou P para cópias em formas 
*retangulares ou **polares 
 
* 
Number of rows (---) <1>: número de linhas , em caso de cópias retangulares.  
Number of columns (|||) <1>: número de colunas , em caso de cópias retangulares.  
Unit cell or distance between rows ( ---):distancia entre as linhas , em caso de cópias 
retangulares. 
Distance between columns (|||):distancia entre as colunas , em caso de cópias 
retangulares. 
 
** 
Base/<Specify center point of array>: ponto central das copias, em caso de cópias 
polares. 
Number of items: número  das copias, em caso de cópias polares.  
Angle to fill (+=ccw, -=cw) <360>: angulo de preenchimento, em caso de cópias 
polares. 
 
Rotate objects as they are copied? <Y> pergunta de os objetos deverão “Y” , ou não 
“N” ser rotacionados ao serem copiados.  
Acesso pelo teclado : array 
Acesso pelo menu : modify > array 
Atalho : ar 
 
 
EXPLODE– desmembra objetos como polylines, mlines e blocos , que são vários 
objetos considerados como um só. 
Entendendo o comando. 
Acione o comando: 
Select objects: selecione os objetos que seram explodidos .  
Caso seje apresentada a mensagem “1 was not able to be exploded” 
Significa que o objeto selecionado não pode ser explodido . 
Acesso pelo teclado : explode 
Acesso pelo menu : modify > explode 
Atalho : x 
 
 
SCALE– amplia ou reduz o tamanho de objetos  
Entendendo o comando. 
Acione o comando: 
Select objects: selecione os objetos que seram alterados .  
Base point: clique no ponto base para alterar o tamanho do objeto. 
<Scale factor>/Reference: de um fator de escala para o objeto , pode ser um valor 
numérico ou apenas um clique na tela.  
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Acesso pelo teclado : scale 
Acesso pelo menu : modify > scale 
Atalho : sc 
 
 
PEDIT– faz edição de polylines ou até mesmo trans forma uma “line” em 
“polyline”. 
Entendendo o comando. 
Acione o comando: 
Select polyline: pede a seleção da polyline.  
Object selected is not a polyline 
Do you want to turn it into one? <Y> 
Caso as 2 mensagens acima forem apresentadas , significa que o objet o selecionado 
não é uma polyline, e pergunta se deseja transforma -lo em polyline 
Close/Join/Width/Editvertex/Fit/Spline/Decurve/Ltypegen/Undo/eXit <X>:estas são 
as opções de edição de polyline, veremos as principais.  
Join – permite juntar duas ou mais polylines , estas devem Ter um ponto em 
comum. 
Fit – cria uma curva suave formada por arcos em cada vértice da polyline.  
Spline – cria uma spline apartir de uma polyline.  
Undo – desfaz a última operação deste comando.  
eXit – sai do comando. 
Acesso pelo teclado : pedit 
Acesso pelo menu : modify > object > polyline 
Atalho : pe 
 
 
DIVIDE– divide um objeto em várias partes iguais desenhando pontos ou blocos 
sobre a entidade. 
Entendendo o comando. 
Acione o comando: 
Select object to divide: pede a seleção do objeto a ser dividido. 
<Number of segments>/Block: pede o número de segmentos para divisão o mínimo 
é 2 e o máximo é 32767,  caso seja acionada a opção Block será pedido o nome de 
um bloco que será desenhado na divisão , caso contrário será desenhado um ponto a 
ser definido pelo comando DDPTYPE. 
Acesso pelo teclado : divide 
Acesso pelo menu : draw > point > divide 
Atalho : div 
 
 
AI_PROPCHK – faz uma variação entre os comandos  DDCHPROP e 
DDMODIFY. 
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O quadro de diálogo pode ser diferente conforme a quantidade e tipo de  objeto que 
for selecionado , ex: selecionados uma linha e um texto, será acionado 
DDCHPROP , selecionando somente um texto será acionado DDMODIFY . 
 
DDCHPROP - Altera propriedades de varios objetos. 
Quadro de diálogo é composto de tres botões principais  
Color... Altera a cor do objeto selecionado.  
Layer... Altera o Layer do objeto selecionado. 
Linetype... Altera o tipo de linha do objeto selecionado (fator de escala da linha).  
 
DDMODIFY Altera propriedades de um objeto apenas .  
Quadro de diálogo é composto de tres botões principais  
Color... Altera a cor do objeto selecionado.  
Layer... Altera o Layer do objeto selecionado. 
Linetype... Altera o tipo de linha do objeto selecionado (fator de escala da linha).  
No caso de seleção de texto, poderá ser  alterada a  altura tipo de texto angulo 
inclinação e largura ,as opções são:  
Heigth – muda a altura do texto. 
Rotation – muda o angulo de rotação. 
Width factor – muda a largura do texto. 
Obliquing – muda o angulo de inclinação das letras.  
Style – muda o estilo de texto. 
Acesso pelo teclado : ai_propchk 
Acesso pelo menu : modify > properties  
 
DDEDIT - Altera o “valor” de um texto.  
Basta acionar o comando e clicar sobre o texto e sugirá um pequeno quadro onde é 
possível modificar o texto. 
Acesso pelo teclado : ddedit 
Acesso pelo menu : modify > object > text  
Atalho : ed 
 
 
MACHPROP - atribui propriedades de um objeto a outro  .  
Acione o comando. 
 
Select Source Object:-  selecione o objeto para obter propriedades . 
Settings/<Select Destination Object(s) – selecione os objetos para atribuir as 
propriedades. 
 
Acesso pelo teclado : machprop 
Acesso pelo menu : modify > object > text  
Atalho : ma 
 



Curso Básico AutoCAD R14 - por Fredy Godinho. - Proibida a venda deste material 
 

 Visite o site  http://www.aditivocad.com                                                26 
 

TRABALHANDO COM BIBLIOTECAS 
 
 
Blocos definem-se pelo conjunto de diferentes entidades que são considerados como 
um só objeto, você mesmo pode criar sua biblioteca de simblos, trabalhando com 
bibliotecas você tem mais produtividade na construção de desenhos, ex: em um 
projeto de arquitetura boa parte do desenho pode e deve ser confeccionado com 
bibliotecas de simbolo , uma porta, janela, vaso etc... constitui uma biblioteca de 
simbolos . 
Nesta parte do curso aprenderemos como construir e trabalhar com bibliotecas, 
através dos comandos BLOCK ,WBLOCK , DDINSERT e BASE.  
 
BLOCK – gera um bloco interno no desenho , um bloco gerado por este com ando 
só poderá ser usado internamente ou seja somente no desenho onde foi criado.  
Entendendo o comando. 
Acione o comando: 
Block name (or ?): pede o nome do bloco a ser criado.  
Insertion base point: pede o ponto base de inserção , que é o ponto pelo qual o bloco 
que será inserido no desenho através do comando DDINSERT. 
Select objects: pede a seleção dos objetos que formarão o bloco.  
Nota: caso o comando for acionado pelo menu ou atalho “bm” será executado 
atráves de uma caixa , que também contém as opções de finidas atrávés do prompt. 
  
Acesso pelo teclado : block 
Acesso pelo menu : draw > block > make...  
Atalho : bm 
 
 
WBLOCK – gera um bloco externo, um bloco gerado por este comando poderá ser 
usado externamente ou seja em qualquer desenho do AutoCAD , este co mando na 
realidade gera um arquivo .DWG e pede por um diretório no qual será armazenado o 
desenho, qualquer desenho feito no AutoCAD pode ser usado como bloco.  
Entendendo o comando. 
Acione o comando: 
Surgirá uma caixa na qual você especificará o diretório e nome do arquivo a ser 
gerado , feito isto clique em Salvar.  
Block name: aqui basta digitar <enter> para confirmar o nome do arquivo.  
Insertion base point: pede o ponto base de inserção , que é o ponto pelo qual o bloco 
que será inserido no desenho através do comando DDINSERT. 
Select objects: pede a seleção dos objetos que formarão o bloco.  
 
Acesso pelo teclado : wblock 
Atalho : w 
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DDINSERT – insere um bloco de uma biblioteca externa ou interna.  
Entendendo o comando. 
Acione o comando: 
Surgirá uma caixa , no botão Block você pode inserir um bloco interno , no botão 
File você pode inserir um bloco externo. Logo após escolher a opção e confirmar 
“OK” seram apresentadas as seguintes mensagens:  
Insertion point: ponto de inserção do bloco 
X scale factor <1> / Corner / XYZ: fator de escala em X . 
Y scale factor (default=X): fator de escala em Y. 
Rotation angle <0>: angulo de rotação. 
Nota: caso prefira você poderá uasr o comando INSERT que tem o mesmo efeito 
com a diferença de ser executado atráves  do prompt  
Acesso pelo teclado : ddinsert 
Acesso pelo menu : insert  > block...  
Atalho : i 
 
 
BASE – muda o ponto de inserção de um bloco externo , para executá -lo basta 
entrar no arquivo que deseja mudar o ponto , acionar o comando e o AutoCAD 
pedirá o novo ponto. 
Acesso pelo teclado : base 
Acesso pelo menu : draw  > block > base  
 
 

DIMENSIONAMENTO 
 
Nesta parte do curso começamos a estudar a parte de dimensionamento de desenho, 
aprenderemos como criar e configurar um estilo de dimensionamento.  
 
Criando e configurando estilos de dimensionamento  
 
O comando de configurações chama-se DDIM e pode ser acessado pelo menu 
format > dimension styles...   ou pelo teclado digitando-DDIM 
Entendendo o comando. 
Acione o comando: 
Surgirá um quadro de diálogo chamado Dimension Style com as  seguintes opções: 
 
Current - Seleciona um estilo de dimensionamento.  
Name - Permite criar um novo estilo ou renomear o estilo atual.  
Rename - Renomeia o estilo pelo nome inserido na caixa de texto Name.  
Save - salva um estilo que tenha sido mudado ou cria do atualizando o mesmo. 
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Geometry - Refere-se as linhas de cota chamada escalas etc... , neste botão aciona o 
quadro Geometry. 
Format - Refere-se a posição do texto setas e linhas guia em relação às linhas de 
cota e de chamada neste botão aciona o quadro Fo rmat. 
Annotation - Refere-se ao texto Prefixo Sufixo unidades de medidas neste botão 
aciona o quadro Anotation. 
 
 Opções do quadro de diálogo Geometry 
Supress - Suprime a 1ª ou 2 ª linha de cota.  
Extension - Define a distância em que a linha de cota se ext ende para além da linha 
de chamada. 
Spacing - Define o espaçamentos de linha de base e dimensionamentos contínuos.  
Arrow Heads - Setas 
1 st - Define a 1ª seta 
2 st - define a 2ª seta  
Size - Define o tamanho da seta 
Extension Line - Linhas de chamada 
Supress - Suprime  a 1ª ou 2ª linha de chamada.  
Extension - Define  a distância em que a linha a llinha de chamada se estende para 
além da linha de cota. 
Origin Off Set - Define a distância entre a origem e o início da linha de chamada.  
Color - Define a cor da linha de cota. 
Center - Criação de centro e eixo. 
Mark - Faz uma marca no centro do círculo ou arco.  
Line - Faz uma marca e uma linha de centro do  círculo ou arco.  
None - Não faz nenhuma marca no círculo ou arco.  
Size - Define o tamanho da linha de centro. 
Scale - Relativo ao tamanho da geometria do desenho.  
 
 Opções do quadro de diálogo Format 
User Defined - Utiliza a opção definida pelo usuário.  
Force Line Inside - Força a linha de cota a ficar dentro das linhas de chamada.  
Text - Define a posição do texto dentro ou fora das linhas de chamada.  
Horizontal Justification - Controla a posição do texto ao longo da linha de cota.  
Vertical Justification - Controla a posição do texto na vertical.  
 
 Opções do quadro de diálogo Annotation 
Primary Units 
Prefix - Insere um prefixo para o texto da dimensão.  
Sufix - Insere um sufixo para o texto.  
Units - Abre um quadro de diálogo com as seguintes opções:  
Units - Apresenta uma lista com as opções de unidades de medidas.  
Dimension - Seleciona um valor de precisão para un idades de medidas. 
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Scale - Defina a escala de unidades de medida, todos os valores encontrados nas 
dimensões serão multiplicados pelo fator de escala especificado neste campo.  
Zero Supression: 
Leading - omite zeros à esquerda. 
Tralling - Omite zeros à direita. 
0 Feet - Omite a apresentação de 0 pés.  
0 Inches - Omite a apresentação de 0 polegadas.  
 
 

Comandos de dimensionamentos 
 
Existem vários tipos de dimensionamentos e eles podem ser utilizados das seguintes 
formas: 
1º - através do menu dimension e escolhendo a opção desejada. 
2º - através do teclado digitando DIM e ficará uma mensagem como DIM: 
permanente no prompt , apartir daí basta digitar a opção desejada.  
Os principais tipos de dimensionamentos são: HORizontal,VErtical, 
RAdius,Diameter,ANgular,ALigned,New,OBLique,HOMe,COntinue 
e  Update. 
No caso de acionamento pelo teclado não é necessário digitar todo o nome , basta 
digitar as primeiras letras destacadas nas especificações acima.  
 
Horizontal - Faz dimensionamento na posição horizontal pedindo um cliqu e em dois 
pontos. 
Vertical - Faz dimensionamento na posição vertical pedindo um clique em dois 
pontos.. 
Radius - Faz dimensionamento de raio de círculos e arcos, pede seleção de objeto.  
Diameter - Faz dimensionamento de diâmetro de arcos e círculos, pede s eleção de 
objeto. 
Angular -  Faz dimensionamento de ângulos, pede seleção de objeto.  
Aligned - Faz dimensionamento alinhado , pede 2 cliques.  
New -  Permite mudar o valor de um dimensionamento existente, pede o novo valor 
e seleção . 
Oblique - Permite alterar o ângulo obliquo de um dimensionamento , pede angulo e 
seleção. 
Home - Permite voltar um dimensionamento que tenha sido mudado anteriormente à 
sua posição de origem , pede seleção.  
Continue - Permite dar continuidade a dimensionamentos tomando como base o 
ultimo ponto e variação de dimensionamento. 
UPdate - Permite atualizar dimensionamentos , o comando pede a seleção e logo em 
seguida atualiza os estilos selecionados para o estilo corrente.  
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LISTAGEM DE INFORMAÇÕES, VARIÁVEIS e 
ATALHOS 
 
 
 

DIST – calcula a distancia e o angulo entre dois pontos.  
Acesso pelo teclado : dist 
Acesso pelo menu : tolls  > inquiry > distance  
Atalho: di 
 
AREA – calcula a area e o perimetro de pontos inseridos.  
Acesso pelo teclado : area 
Acesso pelo menu : tolls  > inquiry > area 
Atalho: aa 
 
LIST – da a listagem das propriedades de objetos selecionados, a listagem varia de 
acordo com o tipo de objeto. 
Acesso pelo teclado : list 
Acesso pelo menu : tolls  > inquiry > list  
Atalho: li 
 
BLIPMODE – caso esteja ligado “on” mostra blips na tela do AutoCAD. 
Acesso pelo teclado : blipmode 
 
MIRRTEXT – caso esteja com valor 0 controla para que os textos não sejam 
espelhados pelo comando MIRROR. 
Acesso pelo teclado : mirrtext 
 
ALIASEDIT – através deste comando é possível modificar ou até mes mo criar 
atalhos dentro do proprio AutoCAD , para criar modificar ou obter a listagem dos 
atalhos através deste comando é necessário que seu AutoCAD tenha sido instalado 
no modo completo “full” . 
Digite o comando e surgirá o quadro onde é possível fazer as  modificações , as 
opções de mudanças são: 
Add –  acrescenta atalhos, para acrecentar um atalho é importante saber o nome 
correto do comando. 
Remove – remove atalhos existentes. 
Edit – renomeia atalhos existentes. 
Apply – aplica as modificações feitas.  
Acesso pelo teclado : aliasedit 
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TECLAS DE FUNÇÃO 
 

ESC à Cancela comandos. 

F1 à Ajuda. 

F2 à Ativa /desativa a tela de textos do AutoCAD.  

F3 à Liga / desliga  os modos de precisão OSNAP. 

F4 à muda o plano TOP LEFT RIGTH . 

F6 à Liga / desliga o Contador de Coordenadas. 

F7 à Liga / desliga o comando GRIG. 

F8 à Liga / desliga o comando ORTHO. 

F9 à Liga / desliga o comando SNAP 

 

 

 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 


